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DISCLAIMER

All statements, technical information, and recommendations in this manual 
and in any guides or related documents are believed reliable, but the 
accuracy and completeness thereof are not guaranteed or warranted, and they 
are not intended to be, nor should they be understood to be, representations 
or warranties concerning the products described. 

COPYRIGHT
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SAFETY INFORMATION

PRODUCT REGISTRATION

WARNING
To reduce risk of fire 
or shock hazard, do not 
expose this product to 
rain or moisture

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT 
REMOVE THE COVER. THERE ARE NO USER 
SERVICEABLE PARTS INSIDE. REFER SERVICING TO 
QUALIFIED SERVICE PERSONNEL.

WARNING

RISK OF ELECTRIC 
SHOCK

DO NOT OPEN

This symbol indicates important 
instructions about the product.

Returning the product registration card or registering with MyTurn.com entitles you to 
receive complementary product support.

Keep your sales receipt as proof of purchase to obtain warranty on parts and service. 
Record your purchase information in case you are asked for them.

Serial No:  

Purchase Date: ________________________________________________

Purchase location: ________________________________________________

________________________________________________

Place sticker from Quick Start poster here.



FEDERAL COMMUNICATION COMMISSION INTERFERENCE 
STATEMENT

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interferences in a 
residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Use only the shielded interface cable provided in order to comply 
with emission limits. Also, any changes or modifications, to this 
equipment, not expressly approved in writing by MyTurn.com, Inc., 
may void the user's authority to operate this equipment.



FOR SERVICE

Refer to your Warranty card for complete warranty terms and conditions. If 
you experience any difficulties with the GlobalPC, contact the service 
department.
Before calling for service on the computer, confirm that the computer was 
installed as described in the enclosed documentation and any necessary 
adjustments were made.
For possible troubleshooting help, you can visit the MyTurn.com web site at:

www.myturn.com

To contact the MyTurn.com service department, call:

(877)-MYTURN1
(877)  698-8761

Hours of operation: 24 hours per day, 7 days per week.
The MyTurn.com service department representative will attempt to resolve 
the warranty issue over the phone. If a telephone resolution is not possible, 
you will receive an RMA (Return to Manufacturer Authorization) number 
that must be included with the returned computer.
To return the computer, include all the components listed in the next section. 
Ensure you remove the diskette if you inserted one in the floppy disk drive. 
Return the computer in its original packaging or similar packaging.

CARE AND CLEANING

Use a soft cloth to dust off the GlobalPC. Plastic surfaces are easily 
scratched or marred by alcohol and other solvents. A nonabrasive, antistatic 
cleaner is recommended. Avoid excessive use of oil-based polishes, they 
tend to attract dust. 



GLOBALPC CONTENTS

Before you start using the GlobalPC, compare the contents of the box to the 
following list. 
• GlobalPC computer
• Quick Start poster
• Warranty card
• Power module
• Keyboard
• Mouse
• Mouse pad
• Telephone cord, 12 ft
• Phone line T adapter
• TV video cable, 6 ft
• TV Accessory Pack

If you are missing any items contact MyTurn.com for a replacement.
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The computer designed with the intention of providing a 
system that is easy to use, with all the functionality you may 
need.
  1

INTRODUCTION
Congratulations on your GlobalPC purchase. A computer you can use to create 
documents, store personal information and access the World Wide Web, also called 
Internet, with an unlimited source of information.
This guide describes how to turn on the GlobalPC and use the GlobalPC programs. To 
ensure that you use the GlobalPC safely and are familiar with the GlobalPC operation, it is 
recommended that you read this guide before using the computer. If you have questions 
about the GlobalPC in the future, use this guide for reference. Additional documentation is 
available on the MyTurn.com Web site.

WHAT CAN I DO WITH THE GLOBALPC?
The GlobalPC contains several programs that you can use to:

• Write letters and reports
• Create graphic pictures
• Store and manage information
• Connect to the Internet to find information
• Send or receive electronic mail (email) from friends and associates
• Play games

The easy-to-use system uses a consistent selection method from one program to another. Once 
you have mastered one program, then you can quickly learn the other programs.
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GLOBALPC GETTING STARTED GUIDE
FRONT PANEL
Take the GlobalPC out of the box and placing it on a flat surface. Turn the GlobalPC so 
that the front of the computer faces you.

The front panel has visual indicators to let you know what 
the computer is doing.

Modem indicator - turns on when the modem is in use. 

Volume - increases or decreases the speaker volume. 

On/Off button - suspends computer operation, similar 
to turning the power on and off on a VCR. It conserves 
power consumption, but never completely turns the 
power off to the computer. Compare this to the rear 
panel power switch, page 1-4.
From any program you are using, you can press the 
power button to turn the computer off, without losing 
any information. Turning the power on resumes 
computer operation from where you left off. For 
example, if you are using the Calendar program, press 
the power button to turn the computer off. Pressing the 
power button again, resumes the Calendar program, 
from where you left off. 

Power indicator - shows the on/off status of the computer. 
1-2



INTRODUCTION
Speakers - two hi-quality stereo speakers on 
either side of the computer.

Microphone connector - reserved for future expansion.

Floppy disk drive - used to store and 
transfer documents. If you inserted a 
diskette in the drive, press the button to 
eject the diskette. The indicator flashes 
when the floppy is in use. Do not remove 
the diskette until the light turns off.

Joystick - reserved for future expansion.

The correct orientation for 
inserting the floppy diskette is 
shown above. The diskette 
label should face up.
1-3



GLOBALPC GETTING STARTED GUIDE
REAR PANEL
Turn the GlobalPC around so the rear of the computer is facing you.

The rear panel contains the connectors for GlobalPC input 
and output.

TV VIDEO - connects to a television video input jack, if available.

TV S-VIDEO – connects to the S-video input of a television, if available. S-
video provides a higher TV resolution than the TV video output. 

Power Cord connector - attaches the 
power module to the computer to provide 
power. Always switch the rear panel power 
switch to the off position before 
disconnecting the power module.

VGA MONITOR - attaches to an optional monitor, providing a higher resolution than a 
television. If this connection is used, the other video connections cannot be used. The video 
connections are described in detail in the Display Installation section, later in this chapter.

Main Power Switch - turns the computer power on or off. Turning the power off removes all power 
to the GlobalPC. When the power is turned on, the computer goes through the restart process. 
Compare this to the power button on the front panel, page 1-2.

Note: Do not switch off the power without properly shutting down the computer using the Unplug 
program from Computer Utilities.
1-4



INTRODUCTION

P
rinter - attach an optional printer.

Audio In - Reserved for future expansion.

Serial port - attach a serial device. Reserved for future expansion.

Modem connector - used to attach the 
GlobalPC to the phone line, which is 
necessary to connect to the Internet.

Audio out - attach to a device such as external speakers

Keyboard connection – attach the included keyboard. The connector is color 
coded to plug into the corresponding color connector. The connector is design to 
plug in a certain way, ensure the it is properly oriented.

Mouse – attach the included mouse. The connector is color coded to plug into the 
corresponding color connector on the back of the GlobalPC. The connector is design 
to plug in a certain way, ensure the it is properly oriented, and firmly seated.
1-5



GLOBALPC GETTING STARTED GUIDE
KEYBOARD BASICS
The GlobalPC keyboard uses a standard typewriter style keyboard layout. Some of the 
keys have a special meaning, as shown in this section.

If you have used a computer before and know the functions 
of the keyboard keys and how to use a mouse, you may want 
to skip to the next section.

Help - specially assigned function 
key to access help information for a 
selected item.

Standard keys - used to enter the 
character indicated on the key cap.

ESC - short for Escape. Typically used 
to close the current window or cancel 
an operation.

Web hot keys - specially assigned function 
keys to access selected Web sites.
1-6



INTRODUCTION
Instant Access keys - specially assigned 
function keys to access the Internet, email, 
calendar, and address book.

Directional or data entry keys - depending 
on the status of the Num Lock key the function 
of the keys can change. If the Num Lock key is 
pressed and the Num Lock light is illuminated 
then the key functions correspond to the 
numbers indicated. If the Num Lock light is off 
then the key functions correspond to the 
directional indicators.
1-7



GLOBALPC GETTING STARTED GUIDE
MOUSE BASICS
If you are new to using a computer and mouse, then the hand eye coordination involved 
with using the mouse may take a little practice. The most important thing you should 
remember is the mouse is made of durable plastic and is hard to break. You do not need to 
be afraid to grasp it firmly, move it around, and click the required buttons. A graphical 
tutorial on using the mouse is available by clicking the Learn key on the keyboard.

MOUSE INSTALLATION
The mouse, included with the GlobalPC, is a standard PS/2 type of mouse. The mouse 
connector is color coded to plug into the corresponding color connector on the back of the 
GlobalPC. See the Rear Panel section, earlier in this section, for the connector location.
Place the mouse on the mouse pad, oriented as shown below. 

The GlobalPC mouse is used to quickly move the screen 
cursor on the display and select a word or object.
1-8



INTRODUCTION
The roller ball, on the bottom of the mouse, must sit flat on the mouse pad for the 
GlobalPC to register mouse movement. As you move the mouse the roller ball movement 
changes the position of the mouse cursor, on the display.

Note: If the mouse cursor starts moving erratically, the mouse may require cleaning. 
Over time dust accumulates inside the mouse. Open the roller ball cover. Look for 
the two roller pins and clean with a damp cloth, if necessary.

USING THE MOUSE
The mouse has two buttons which have specific functions. The left button is used to select 
text, cursor position, and window buttons. The right button is used to show help 
information and several optional menus.
When you click a button, press the button without moving the mouse. The best way to do 
this, is while holding the mouse with your thumb and last finger and your palm resting on 
the mouse, use your index finger. If you click and move the mouse at the same time, you 
may select something other than what you intended.
You can practice improving your mouse usage skills by using the Mouse Skills tutorial 
from the Learning Center. You access the Learning Center by pressing the Learn key, on 
the keyboard.
1-9



GLOBALPC GETTING STARTED GUIDE
DISPLAY INSTALLATION
The term display is used to refer to the viewing device for the GlobalPC. The two choices 
are:

• Television

• Monitor

If you have a television, you can use it to connect the GlobalPC. You do not need to 
purchase a separate monitor.
The term screen refers to the image that you see on the display.

Note: You can use a television or monitor. You cannot use both devices at the same time.
The display connected to the computer is automatically detected. The MAIN 
POWER switch must be turned off and then on before switching the displays, to 
detect the display type.

TELEVISION DISPLAY
The GlobalPC has a TV video output jack that connects to a televisions input jack. If your 
television does not have an input jack, you can use the TV converter  which converts the 
signal to an F-type coaxial (cable system style) connector. If your television set only has a 
300 ohm input, you can add a 75 ohm to 300 ohm matching transformer.
If your television has an S-video connector you can use the S-video output, with an 
optional S-video cable, to connect the GlobalPC to the television. The S-video signal 
offers improved clarity then the TV video output.

You can use a television or monitor to view the GlobalPC 
information, the choice is yours.
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INTRODUCTION
TELEVISION CONNECTION USING THE TV VIDEO CONNECTOR
The GlobalPC can be connected to a television using the TV video connector and the 
included TV video cable.

Note: Remember to turn on the television before turning on the GlobalPC.

You need to change the signal input source for your television to see the GlobalPC screen. 
If you are not sure how to change the television, refer to the documentation that came with 
your television.
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GLOBALPC GETTING STARTED GUIDE
TELEVISION CONNECTION USING THE TV CONVERTER
The GlobalPC can be connected to older television sets that do not have a video connector 
using the TV Converter.
Refer to the TV Accessory Pack for the proper installation procedure.

Note: Remember to turn on the television before turning on the GlobalPC.
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INTRODUCTION
TELEVISION CONNECTION USING AN S-VIDEO CABLE
If your television is equipped with an S-video connector, you can connect the GlobalPC to 
the television using an optional S-video cable. The GlobalPC display is clearer using the 
S-video connection. 

You need to change the signal input source for your television to see the GlobalPC screen. 
If you are not sure how to change the television, refer to the documentation that came with 
your television.
You can improve the television image by using the Stop Crawling Dots and Black and 
White settings in the Video settings of Preferences. It is recommended you increase the 
sharpness setting on the television, if available.

Note: Remember to turn on the television before turning on the GlobalPC.
1-13



GLOBALPC GETTING STARTED GUIDE
MONITOR DISPLAY (OPTIONAL)
You can purchase an optional monitor that provides a higher resolution and clearer image. 
The default resolution is 640 x 480 pixels. With the monitor you can view the screen at 
800 x 600 pixels. The higher resolution also shows more information on the screen at one 
time. Refer to the Preferences program on how to change the screen resolution.

Note: Remember to turn on the television before turning on the GlobalPC.
1-14



INTRODUCTION
MODEM CONNECTION
The modem connection allows you to connect to the MyTurn Online Internet and email 
service. The Modem indicator on the front panel shows the status of the modem 
connection.

If you have an existing phone connected to the phone jack, you can add a T-adapter 
(included) to split the line and connect both devices.

Note: You cannot talk on the phone and use the modem at the same time. While using 
the modem, you will not receive any phone calls and callers will not be able to 
reach you or reach devices such as phone answering machines.

During the GlobalPC registration process you can select the option to temporarily disable 
call waiting when using the GlobalPC modem. Call waiting can interrupt the modem 
communication and cause it to drop the MyTurn Online connection.

A modem is used to dial a telephone number with the 
GlobalPC.
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GLOBALPC GETTING STARTED GUIDE
PRINTER INSTALLATION (OPTIONAL)

You can purchase the optional GlobalPC color ink-jet printer to print your documents.

USING A PRINTER
To use the printer, connect it as described in the documentation included with the printer. 
Turn on the printer power before turning on the GlobalPC power. Follow the instructions 
included with the printer to install the print cartridge and paper. 
The GlobalPC has the appropriate print driver already installed to support the GlobalPC 
printer. There is limited print driver support for other types of parallel interface printers. 
You can visit the Support area of the MyTurn Online Web site to see if a print driver exists 
for your printer.

A printer allows you to create paper documents from the 
documents you create on the GlobalPC.
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INTRODUCTION
GLOBALPC STARTUP
Ensure the following components are connected to the GlobalPC, as described in the 
Quick Start poster.

• Power module
• Keyboard
• Mouse
• Television or monitor
• Phone line

After connecting the external components you are ready to turn on the power and start the 
GlobalPC.

TURNING ON THE POWER
When you are ready to start using the GlobalPC turn on the power to the monitor and the 
GlobalPC. The GlobalPC has a power switch on the front and rear panel. The following 
sections describe the function of each switch.

USING THE REAR PANEL POWER SWITCH
The rear panel power switch turns the power on or off, to the GlobalPC. The GlobalPC 
goes through the entire startup process each time you turn on the rear panel Main Power 
Switch. Use this switch if:

• This is the first time you turn on the GlobalPC
• You are not going to be using the GlobalPC for a long period
• You are experiencing electrical outages or electrical storms
• You plan on moving the GlobalPC to a new location
• You switch the display from television to monitor or vice versa

For everyday operation you should use the front panel power switch

The startup process occurs each time you turn on the 
GlobalPC.
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USING THE FRONT PANEL POWER SWITCH
The GlobalPC has an instant-on power feature. This lets you turn off the GlobalPC and 
then turn it on and resume operation from where you left off. To use this feature the rear 
panel power switch must be in the On position.

Turning off the power from the front panel power switch places the GlobalPC in sleep 
mode. In suspend mode the power is turned off to all non-essential components, thus 
conserving power. 

INSTALLING SOFTWARE 
The GlobalPC contains all the necessary software that you need, out of the box.

BOOTING THE GLOBALPC
The process of turning on the power and starting the GlobalPC is called booting the 
computer. The GlobalPC logo displays until the boot process completes and the GlobalPC 
desktop displays.

FIRST TIME REGISTRATION
The first time you boot the GlobalPC a series of screens display requesting information 
from you to register and set up the computer. The information is necessary if you intend on 
using the GlobalPC Online Internet and email service. If you are unfamiliar with Internet 
and email services see Appendix B - Special Characters

SETTING TIME AND DATE
Several screens display to set the correct date and time for you computer. Setting the 
correct date and time are important to using the Calendar program and time-stamping 
emails and documents.
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INTERNET REGISTRATION
Several screens display to enter registration information for the MyTurn.com Internet 
service. If you do not register then you cannot access the Internet and use the email 
service.

Note: Internet registration is not a necessary step to use the GlobalPC. If you skip the 
registration, you can register later, at any time by clicking the Sign Up button from 
the desktop.

The Internet service requires payment with a credit card. Be prepared to provide the credit 
card information during the registration process.

Note: Your credit card number and registration information is never sold to other 
companies for marketing purposes. All information is kept secure by MyTurn.com 
and not given to any other company.
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THE DESKTOP
The desktop is the visual area that you see, where you click on buttons, enter text, and do 
other GlobalPC tasks. You can choose from the easy-to-use desktop, called the GlobalPC 
desktop, or the enhanced desktop, called the Advanced desktop. The Advanced desktop is 
more complicated to use, but provides more program features and options.

GLOBALPC DESKTOP
The GlobalPC desktop is your starting point to using the GlobalPC programs. From here 
you click on screen buttons to select additional screens or start a program. This desktop is 
for the user that wants to use a simple, uncluttered way to select and use the GlobalPC 
programs.

Everything you do on the GlobalPC, occurs on one of two 
desktops. You can select the GlobalPC desktop or Advanced 
desktop.

Screen button – clicking 
on button selects the 
indicated choice.
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The GlobalPC desktop is the default screen whenever you power on GlobalPC from the 
Main Power switch, on the rear panel. If you turn the GlobalPC on using the Resume 
function by pressing the front panel power switch, the last used desktop displays.

ADVANCED DESKTOP
The Advanced desktop is for the user who requires less guidance and wants to use menus, 
folders, and a window style display. The Advanced desktop provides more features.
From the GlobalPC desktop, select the Advanced desktop from the Computer Utilities 
menu. From the Advanced desktop you can always return to the GlobalPC desktop by 
clicking on the GlobalPC icon.

Window – lists documents and 
programs, show the document 
contents, and display messages.

Folders – used to organize files into categories. 
Some folders can contain documents, while other 
folders may contain programs.

Express menu – 
used to select 
programs and 
program options.
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If you turn on the GlobalPC using the Resume function, by pressing the front panel power 
switch, and the Advanced desktop was used last, then the Advanced desktop displays. If 
the GlobalPC is powered on from the Main Power switch, on the rear panel, the Advanced 
desktop displays.
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“Before you can run, you need to learn how to walk”
If you have used computers before, you may want to skip this 
chapter.
  2

GLOBALPC DESK-
TOP
This chapter describes the essential skills needed to use the GlobalPC programs from the 
GlobalPC desktop. Several electronic tutorials are available on the GlobalPC that cover 
the computer, keyboard, and mouse usage. You can run the tutorials by pressing the Learn 
key on the keyboard.

SKILLS OVERVIEW
The following skills are described in this chapter.

• Opening a Program – select and start a program
• Using the Help Window – how to use program features
• Using Program Windows – buttons, scroll bars, and drop-down list boxes
• Entering and Selecting Text – copying, pasting, deleting text
• Using Documents – manage contents of documents
• Using the Clipboard – cut, copy and paste text or graphics
• Using Special Characters – add characters to a document not on the keyboard
• Saving a Document – store information for future reference
• Closing a Program – put away programs not used
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OPENING A PROGRAM
A program is a type of instruction that you select which tells the GlobalPC what to do. 
Similar to a microwave when you press the Cook button. Pressing the Cook button tells the 
microwave to turn on the power and cook the food at a specific temperature. That is a type 
of program.
Just as pressing the microwave Cook button performs the cook program, you click on 
GlobalPC screen buttons to perform GlobalPC program or function.

Some screen buttons start a program that opens a document, such as a letter. Other screen 
buttons start a program that performs a specific function, such as the calculator or calendar 
or display another screen with more screen buttons. Screen buttons require only a single-
click to do the indicated action.

Example of opening the Calendar program

1. From the Main screen, click on the Organize screen button.
A secondary screen displays.

2. Click on the Calendar button to open the Calendar program.

Screen
button
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USING THE HELP WINDOW
As you use the GlobalPC, there may be certain features that you are not sure how to use. 
You can display a Help window which describes the feature and how to use it.
There are three ways to open a Help window:

• Press the F1 key, on the keyboard
• Click the right mouse button
• In a window, click the Help button.

After displaying the Help window you can:
• Click Contents to always return to the beginning Help page for the current program.
• Click Back to return to the previous Help page.
• Click History to display the list of Help windows you previously visited. Click on a 

Help topic to re-display the information about that topic.
The History list contains the names of the ten most recent Help windows viewed. If 
you view more than ten help topics, the oldest topic is removed from the top of the list 
and the most recent topic is placed on the end of the list.
When you close the Help window the History list is deleted. 

LINKS TO OTHER INFORMATION
Within the help text, you may see words or phrases that are colored blue and underlined. 
This type of text is called hypertext. If you click on hypertext, additional help information 
is displayed relating to the selected word or phrase.
As you place the mouse cursor on hypertext, notice the cursor changes to a question mark. 
This indicates the word or phrase is indeed hypertext.
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USING PROGRAM WINDOWS
As you work with GlobalPC programs, you will notice similarities on how you select 
screen items, enter text, and change text in programs and documents. The principles apply 
to any program or document.

Sub menus – a menu item with a 
right arrow indicates a sub-menu. 
Click on the desired menu item to 
select it.

Menu bar and menus – from the 
menu bar click on menu item to 
display a corresponding menu.

Fields – used to enter text. To the left of each 
field is a field name. After clicking on the field 
the flashing cursor indicates you can start 
typing in the field.

Pull-Down Menus – used to select an item from a predefined list. 
Clicking on the field selector, to the right of the field, displays the 
list. Clicking on the desired item places the item in the field.
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ENTERING AND SELECTING TEXT
When using the GlobalPC programs, you will notice similarities in entering, selecting, and 
changing text in documents and fields. The examples in this section use the Writer 
program, but the principles apply to any program.
After creating a new document in the Writer program, a blank screen displays with the 
flashing text cursor.

The text cursor indicates where the next character appears when you press a key on the 
keyboard.

ENTERING TEXT
The first step to creating the contents of a document is entering text. To practice this, type 
the following sentence.

After typing the phrase, you realize that the word nickel should be penny. How do you 
change it?

Text
Cursor
2-5



GLOBALPC GETTING STARTED GUIDE
SELECTING TEXT
With the text cursor at the end of the line, you can press the Backspace key until you erase 
nickel. However, this also erases everything after nickel which means you have to type the 
rest of the sentence again. You could press the left arrow key, which moves the text cursor 
to the left, until it is positioned to the right of nickel and press Backspace to delete the 
word.
A simpler way is to position the mouse cursor at the beginning or the end of nickel, 
Without moving the mouse cursor, click and hold the mouse button and then move the 
mouse right or left to highlight the word. The selection should appear as:

Notice when the mouse cursor moves onto the document, the cursor changes. Other ways 
to select a word, sentence or paragraph are:

• Double-click on a word to select the word
• Triple-click to select the sentence
• Quadruple-click to select the 

paragraph. 

CHANGING TEXT 
After highlighting text that you want 
to delete, press the Delete key. You 
can also highlight text and start 
typing. The selected text is deleted 
and the characters display, as you 
type. After deleting the word nickel, 
type penny.

Text Editing Guidelines
Do not press Enter at the end of each line 
when a paragraph goes past the end of a 
line.

Do press Enter at the end of each 
paragraph.

Do press Backspace to delete the character 
to the left of the cursor or Del to delete the 
one to the right.
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USING DOCUMENTS
You create documents when you open a program and type in text or other kind of 
information. The document is only temporary, in the computer memory, until you turn off 
the computer. After turning off the power the document is lost.
To store a document for future use, you save the text or information you entered as a 
computer file to the computer hard disk or floppy disk drive.

After creating a document, you can –

Delete it Save it to a diskette

Save it on the GlobalPCPrint it
2-7



GLOBALPC GETTING STARTED GUIDE
USING THE CLIPBOARD
The clipboard is a temporary storage area in the computer memory where text and 
graphics are stored as you cut, copy, or paste items within a program or between programs. 
Every time you cut or copy text or graphics the item is automatically placed in the 
clipboard. Then when you paste the item the clipboard contents is inserted where you 
specify.
The clipboard always contains the most recent copy or cut item. For example, in a 
document containing the words NEW AGE, you select and copy the word NEW and then 
select and copy the word AGE. When you paste the clipboard contents only the word AGE 
appears.

USING SPECIAL CHARACTERS
Special characters are symbols and letters that you may want to insert into a document that 
do not appear on the keyboard. For example, a special character might be the trademark 
symbol (™) or the plus minus symbol (±).

Using Special Characters

Special characters are inserted from a program.
1. From a program, such as Writer, position the cursor where you want to insert the char-

acter.
2. From the Edit menu, select Special Characters.

The Insert Special character window displays the URM Mono font characters, the 
default GlobalPC font.
All the characters for the selected font are shown. You can select a different font from 
the Select Font field to show all the characters available.
Clicking and holding a character enlarges the character.

3. Click on the character you want to insert.
4. Click Insert into document.

The character appears in the document.
5. When you are done inserting characters, click Close.

The Insert Special Character window remains open until you click Close.
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SAVING A DOCUMENT
Saving a document places a copy of the current document you see on the screen, which 
resides in the computer memory, on the hard drive or on a floppy diskette. You can then 
open the document at a later time to review the document, make changes, or print the 
document.

To save a document

From the File menu, select Save.
If the document was not previously saved, the Save As window displays. You need to 
specify a document name the first time a document is saved. The next time the 
computer knows the document name and will automatically save the current document 
under the current document name.

CLOSING A PROGRAM
When you are finished using a program, you can close the program to use a different 
program or turn off the GlobalPC. The process of closing a program depends on which 
desktop you are using.

To Close a Program

With the GlobalPC Desktop you can have one program open at a time. To use different 
programs, you must close the current program to open another one.
1. From the File menu, of most programs, select Done.

or
Click Done in the upper right corner of the program window.
The Done confirmation window displays.
If the document contents changed since you last saved the document, click Save to 
save any changes made. If you do not save the document and click Close, all the 
changes will be deleted.
Click Print to print the current document.
Click Go back to return to the program.

2. Click Close to close the program.
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Open multiple programs and multiple documents at one 
time, using a Window style screen.
  3

ADVANCED DESK-
TOP
The Advanced Desktop features, described in this chapter, build on the GlobalPC desktop 
features learned in the previous chapter.

OVERVIEW
The following features are described in this chapter.

• Opening a Folder – view the contents of a folder
• Opening a Program – select and start individual programs
• Setting Program Levels – select the visible features in a program
• Using Special Characters – add characters to a document not on the keyboard
• Closing a Program – put away programs not used
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OPENING A FOLDER
Folders are used to organize documents into defined compartments. You can store all your 
documents in the single default Documents folder. However, over time as you create large 
amounts of documents you may want to categorize documents into logical groupings. For 
example, all documents relating to the bank could be stored in the Bank folder. Then, 
when you need to reference a particular document you might have an easier time finding 
the document by categories.
From the Advanced Desktop, programs and documents are stored in folders represented 
by icons. The first time you use the GlobalPC, documents are stored in the default folder 
called Documents. From the Documents folder you can create other folders.

Note: If you plan on switching between the GlobalPC Desktop and Advanced Desktop, 
do not use folders. The GlobalPC Desktop can only access the Documents and 
Archive folders, no sub-folders.

To open a folder

Right-click on a folder icon, select Open.
or

Double-click the selected folder icon.
For example, double-click the Document icon. A second window displays the 
documents within the folder.
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OPENING A PROGRAM
You open a program to work with documents or do a specific task, such as using Address 
Book.

To open a program

You can open a program from the Express menu or folders and icons on the desktop. The 
following steps use the Writer program as an example, but the process can apply to any 
other program.

Using the Express menu

1. From the Task bar, click Express Menu.
A menu list displays.

2. Click Programs.
3. From the sub-menu, click Writer.

The program window displays.

Using Icons

1. Right-click on the Home Office icon, select Open.
or

Double-click the Home Office icon.
A second window displays the programs within the folder.

2. Select the Writer icon and from the File menu, select Open.
or

Double-click the Writer icon.
The program window displays.
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SETTING PROGRAM LEVELS
Some of the GlobalPC programs have the Program Level option, which puts you in control 
of selecting only those features of the program you want to see. You can hide or show 
selected features of the program.
Program Level 1 is the lowest level with the least amount of features enabled. Program 
Level 4 is the highest level with the all the features enabled. 
The first time you use a GlobalPC program, the program level default is 1. You can change 
the Program Level as needed.

To change the Program Level

1. Start a program, such as Writer.
The default view using Program Level 1 displays.

2. From the Options menu, select Change Program Level.
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The Change Program Level window displays.

Clicking on one of the four numbers selects a default set of Program Level features. To 
see which features are selected click Fine Tune. From Fine Tune, you can manually 
select which features you want to have enabled or disabled. 

3. Click the 4 screen button
4. Click OK to select the change.

The program window displays with the selected features. 

Notice the screen in Step 1 shows less options than the screen in Step 4.
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You can change the Program Level at anytime while using a program. If you make 
Program Level changes a message window displays when you exit the program, to save 
the changes. If you do not save the changes, the last saved Program Level is selected the 
next time you use the program.

USING SPECIAL CHARACTERS
Special characters are symbols and letters that you may want to insert into a document that 
do not appear on the keyboard. For example, a special character might be the trademark 
symbol (™) or the plus minus symbol (±).
Character Map is a program used to insert special characters into a document. A character 
map window displays all the characters available for a selected font. You can select 
different fonts and see the special characters available for the font.

To run the Character Map program

1. Click Express Menu.
2. Click Programs.
3. Click Accessories.
4. Click Character Map.
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CLOSING A PROGRAM
When you are finished using a program, you can close the program to use a different 
program or turn off the GlobalPC. 

To Close a Program

1. From the File menu, of most programs, select Exit.
or

Click the X symbol in the upper right corner of the program window.
If the document contents changed since you last saved the document, a window 
displays with the option of saving the document before closing the program.
If no changes were made to the current document the program closes without the 
confirmation window.
If you do not save the document and click Close, all the changes are deleted and can 
never be recovered.

2. To save the document, click Save It.
If the document was not previously saved, such as a new document, the Save As 
window displays. Enter the document name and click Save. The document is saved 
and the program closes.
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A program is the function you select to tell the computer 
what to do. 
  4

PROGRAMS
This chapter describes some of the GlobalPC programs, using the GlobalPC Desktop. The 
same programs are available from the Advanced Desktop, but the selection process varies.
You select and run a program to perform a specific set of functions. For example, when 
you select and run the Calendar program, the Calendar window displays, showing the 
specific program functions.
For additional information about using certain programs not described in this chapter, 
refer to the MyTurn.com Web site.

OVERVIEW
Programs are grouped within suites or categories on the GlobalPC Desktop, as follows:

• Communication Suite
• Global Email – send and receive electronic messages
• Global Internet – explore World Wide Web information
• Chat – exchange instant messages with other computer users
• NewsReader – read and post electronic messages from computer users

• Home Office Suite
• Writer – create and print text documents
• Artist – create and print graphical documents
• Spreadsheet – organize text and numerical information into rows and columns
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• Information Organization Suite
• Address Book – keep track of personal names, addresses and phone numbers
• Banker – organize financial information, similar to a checkbook
• Calendar – keep track of schedules and appointments
• Database – keep track of information, such as recipes or a catalog videotapes

• Play and Learn Suite
• Crossword – a word association game, with new games weekly
• Learning Center – use a tutorial to learn about the GlobalPC
• Solitaire – a classic card game
• Tetris – a popular russian strategy game

• Computer Utilities Suite
• Add & Delete Software – install or remove GlobalPC programs
• Backup Manager – create a copy of your GlobalPC documents
• Dial-up & Configure – configure the modem dialer and Internet access settings
• Preferences – change selected computer settings, such as sound, date and time, 

screen saver, and others
• System Update – update the GlobalPC with the most recent changes
• Unplug GlobalPC – before moving the GlobalPC, this is the recommended method 

of shutting down the GlobalPC and turning off the MAIN POWER switch.

STARTING INDIVIDUAL PROGRAMS
To use any of the GlobalPC features, you click on items on the screen, which then starts a 
process called a program. Different programs have different functions. One program can 
be used to create text documents, another program can be used to organize a long list of 
information.

To start a program:

From the GlobalPC Desktop click on one of the screen buttons to start the desired 
program. For example, to start the Internet program, click on the Internet and email button. 
This takes you to a secondary screen with another list of choices. Clicking on the Browse 
the Internet button starts the Global Internet program.
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COMMUNICATION SUITE
The Communication Suite programs use the GlobalPC modem to communicate with the 
Internet to exchange information with other computer users. You can browse the wealth of 
information available on the Internet, send and receive electronic messages from fellow 
computer users, interactively chat electronically with other GlobalPC users, and read 
messages posted by other computer users to electronic bulletin boards.
The Communication Suite programs are:

• Global Internet
• Global Email
• NewsReader
• Chat

GLOBAL INTERNET
Use the Global Internet program to connect to the World Wide Web to shop for products 
and find information. 

To start Global Internet:

1. From the GlobalPC Desktop, click Internet and email.
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The Internet and email screen displays.

2. Click Browse the Internet
The Global Internet window displays.

By default, the MyTurn.com Home Web page displays. The MyTurn.com Web site 
offers a wide variety of features, from the latest news, weather, and sports from CNN 

Web page area

Window buttons
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to shopping in the MyTurn.com online mall, searching the Internet, and meeting 
others in the MyTurn.com online communities.
For an overview of what the Internet is, see Appendix B - Internet Basics.
The Global Internet window options are:
• Web page area – the area within the window that shows the Internet information 

you requested.
• Goto button – opens a window to enter a Web page address. You can select Show 

Goto Bar, from the View menu, to always display the Goto field.
• Reload button – refreshes the current Web page with the most recent information. 

Sometimes a Web site may encounter a communication error and will not finish 
loading all the information. You can click Reload to request all the information for 
the current page be sent again. This is also useful for pages that display changing 
information, such as stock quotes. Each time you click Reload the stock prices are 
updated.

• Home button – displays the MyTurn.com Home page.
• Back button – is activated once you have selected two or more Web pages. You can 

go back to a previous Web page you selected.
• Next button – is activated once you have selected two or more Web pages. If you 

went back to a previous page, you can go forward to a Web page you already 
selected.

• Stop button – after entering a Web page address from the Goto window and before 
the Web page is downloaded, click Stop to stop the download.

To browse the MyTurn.com Web site.

The MyTurn.com Home page is a single page within the MyTurn.com Web site. On the 
Web page area, when the mouse cursor moves over a link, you will notice the mouse 
cursor changes to a hand. Click on any link, within the Web page area, to jump to another 
Web page.

To browse the Internet:

1. To go to another Web site on the Internet, click the Goto button.
The Goto window displays.
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2. Enter the Web page address you want to go to.
3. Click Goto.

The desired Web page displays, once the Web page information is obtained from the 
selected Web site.
If you get an error that the Web page is not available, try entering the address a second 
time. Sometimes a Web site may be too busy, or you entered an incorrect address.

GLOBAL EMAIL
Use the Global Email program to send electronic mail (email) messages to and receive 
email messages from other computer users. The other computer user does not have to have 
a GlobalPC, only an email address.
An email is an informal note that you send from one person to another or from one person 
to many people. One advantage of email is you can send one message to many people at 
the same time.
An email address is similar to a street address. It is unique and identifies each person using 
a particular computer. An email address consists of a name defined by each individual. For 
example, Jane Doe might identify herself as jdoe, j_doe or JaneD. A name can be upper or 
lower case and contain the underscore character (_), but cannot contain spaces. 

To start Global Email:

1. From the GlobalPC Desktop, click Internet and email.
The Internet and email screen displays, as shown in the Global Internet section.

2. Click Email
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The Global Email window displays.

3. Select the desired option.

Creating a New Email Message
To send an email message to another person you open a new message window, type in the 
message contents, and send the message.

To create a new email message:

1. From the Global Email window, click New Message.
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The New Email Message window displays.

The window options are:
• Send To field – enter the address to which the email is being sent. You can enter 

multiple addresses by separating the names with a semicolon (;). For example, a 
message sent to Ken and Belinda would appear as:

ken@computer.com; belinda@myturn.com

• Subject field – enter a short phrase, describing to the person receiving the message 
what the message is about

• Message text area – enter the message content. The format is whatever you want it 
to be.

• Attach button – include a document with the email
• Send Now button – send the current email to the address(es) in the To field.
• Send Later button – create multiple email messages and save them to send all at 

once, at a later date.
2. Enter the address of the person to whom you intend on sending the email
3. Enter the message text.
4. Click Send Now.

Message text area
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Reading an Email Message
You can read an email message by selecting it from the message list and then opening it.

To view the contents of a message:

1. From the Global Email window, click Read Email.
The Global Email window displays with the email messages you received.

Messages are listed in the message area by subject, author, and date, but not the actual 
message content.

2. Select the message you want to read.
3. Click Open Email.
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The Email Message window displays.

When viewing a message, the following buttons appear.
Reply - send an email back to the same address from whom you received the email. 
The reply includes the text from the current email for reference. A reply email can be 
used to maintain a message flow in an ongoing conversation. Each reply is added to 
the bottom of the existing text.
Reply All - send an email back to all the addresses in the To and Cc fields.
Forward - pass an email along to another address. To the person receiving the email, 
the message appears as a new email from you. You enter a new email address and can 
add text to the message body.
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Replying to an Email Message
When you reply to an email message that someone has sent you, the entire contents of the 
original message is automatically included in the reply message.
A message reply is sending a message back to the person who sent you the current 
message. All the contents of the message you received is automatically included in the 
reply message. You can add comments to the email or delete some or all of the reply 
message.

To reply to a message:

1. From the message list in the Global Email window, click on the message you want to 
read.

2. Click Open Mail.
The message window displays, as shown in the previous section.

3. Click Reply.
By clicking Reply All you can send a reply message to everyone who received the 
original message.
The New Email Message window displays.

The cursor automatically appears at the end of the original message.
4. Type your reply message.
5. Click Send.
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NEWSREADER
Use the NewsReader program to read messages posted by other computer users to any 
Usenet newsgroup you subscribe to. 

To start NewsReader:

1. From the GlobalPC Desktop, click Internet and email.
The Internet and email screen displays.

2. Click NewsReader
The NewsReader window displays.

The first time you use NewsReader, no newsgroups are displayed because you are not 
subscribed to any.
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Subscribing to a Newsgroup
There are thousands of newsgroups that you can subscribe to. Which ones you want to 
subscribe to is a matter of personal preference. It will take some experimentation to find 
the ones that provide you the most information or match your desires.

Note: Be aware that many newsgroups can contain material that you may find offensive. 
If you have children, you can setup KidGuard to deny access to newsgroups.

To subscribe to a newsgroup:

1. From the NewsReader window, click Newsgroups and select Add a Newsgroup.
The Add a Newsgroup window displays.

The first time you use NewsReader, there are no newsgroups listed.
2. Click Update List.

A search begins of all the available newsgroups that MyTurn.com provides. There are 
thousands of newsgroups, so if you get tired of searching, click Stop.
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The newsgroups found are listed in the List of newsgroups field.

3. Scroll through the list of newsgroups and select one that sounds like something you 
would be interested in.

4. Click Add.
The NewsReader window displays again, with the list of messages found in the 
newsgroup.
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If the selected newsgroup does not contain any messages, the No news in this group 
message displays. You can go back and add a different newsgroup.

Reading a Message
From the list of messages, you can select and open any message to view the information.

To read a newsgroup message:

1. From the NewsReader window, select the desired message.
2. Click Read.

The Message window displays.

From the Message window you can reply to messages or print messages.
3. Click Done to close the message and view other messages.

CHAT
Use the Chat program to interactively communicate with other GlobalPC users.
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To start Chat:

1. From the GlobalPC Desktop, click Internet and Email.
The Internet and Email screen displays, as shown in the Global Internet section.

2. Click Chat.
A connection is automatically established with MyTurn.com and the Chat Central 
Web page displays.

3. Click on the desired category
If you have not registered as a chat user, several screens display prompting you to 
register. 
After completing the registration, click on the desire category again.
The Chat window displays for the selected chat room. The following is an example of 
the chat room window for Gardening.
The Chat window for that room displays.

The current chat room participants are shown along the left side of the screen.
The chat discussion area shows the messages.
To add your comments to the chat session, for other users to see, type your comments 
in the Chat field, at the bottom of the screen and press Enter or click the Send button 
next to the field.

4. Click Done to close the Chat session.
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HOME OFFICE SUITE
The Home Office Suite of programs provide the essential tools to create text and drawing 
documents, organize information into rows and columns and use formulas to calculate 
numerical values, and create banner signs.
The Home Office Suite programs are:

• Design Assistant
• Writer
• Artist
• Spreadsheet
• BannerMaker

DESIGN ASSISTANT
The Design Assistant guides you through the process of creating documents, using 
predefined formats. You can create text documents, certificates, cards, announcements, 
and many other types of documents.

To create a Birthday Party announcement:

1. From the GlobalPC Desktop, click Create and Use Documents
The Create and Use Documents screen displays.
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2. Click Design Assistant.
The Design Assistant window displays.

3. Click Invitations.
4. Click Birthday Party.
5. Click Next Step.
6. Enter the date and time of the party and click Next Step.
7. Enter the location of the party and click Next Step.
8. Click Next Step.
9. Click Finish.

The birthday party document displays. This particular design assistant uses the Artist 
program. You can save this document and return to Artist later to make changes, or 
print and fold the card.

10. Click Done to close Artist and return to the Design Assistant.
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WRITER
Writer is a word processing program used to create documents containing text and 
graphics. You see one page of text at a time, with the margins. Only text within the 
margins is printed.The basics of entering, selecting, and changing text is accomplished by 
typing, selecting text with the mouse, and using the tools.
In addition to the basics, Writer has special features with which you can make documents 
visually more appealing.
Some of the special features are:

• Apply different font types and sizes to selected text
• Apply different text styles
• Change paragraph spacing and orientation
• Spell check documents
• Insert graphics from Artist

Opening and Closing a Writer Document

To start Writer

1. From the GlobalPC Desktop, click Create and Use Documents.
The Create and Use Documents screen displays, as shown in the Design Assistant 
section.

2. Click Blank Document.
4-19



GLOBALPC GETTING STARTED GUIDE
The Create something from a blank page screen displays.

3. Click Blank Page.
The Writer window displays.

The Title bar, at the top of the window, shows the name of the program and the name 
of the current document. When you create a blank document the document is called 
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Untitled, by default. You need to save the document to give the document a name, 
which also stores any work you do for future retrieval.

To save the new document:

1. From the File menu, click Save.
Since the document has not yet been defined, the Save As a New Document window 
displays.

2. For the example used in this guide, type the following:

My writer file

3. Click Save.
The Writer window displays with the document name in the Title bar.

To close Writer:

1. From the Title bar, click Done.
The Done window displays.

If you did not save the document, the Save it so I can use it again later button is 
available. Click the button to save the document before closing the program. If you do 
not save the document, any changes you made since the document was last saved are 
deleted.
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If you want to print the document before closing the program, click the Print my 
document button.
If you decide that you do not want to close the program at this time and want to return 
to the document to continue working on it, click the Go back to my document button. 

2. Click Close the document and exit Writer button.

Using Writer
After creating a blank document, the Writer window displays, ready for you start creating 
your document. This section explains how to use some of the Writer tools to create a 
document similar to the one shown below.

The flashing cursor in the upper left corner of the document area indicates where the next 
character is placed when you press a key on the keyboard. This is the spot from which you 
start creating the document.

To enter the text:

1. Type the phrase:

You’re Invited

2. Press Enter.
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3. Type the phrase:

... to a wonderful evening of

4. Press Enter.
5. Type the phrase:

jazz and

6. Press Enter.
7. Type the phrase:

wine and cheese

8. Press Enter.
You will notice that all the text is too close together and not very eye catching. Next 
we want to select all the text and change the line spacing.

To select all the text:

Selecting any text or graphic on the screen is accomplished by using the mouse. The 
purpose of selecting text and objects is to apply the effects of a selected tool. To change 
the style of a word, you need to select the word and apply the style.
1. Position the mouse cursor where you want to start the selection.

For this example, you are going to select all the text you typed, starting from You’re. 
Move the mouse cursor before the y in You’re.

2. Click the left mouse button.
The text cursor should move in front of the Y in You’re. However, when you click the 
mouse button, the cursor must be placed inside the text margin. If you click outside the 
margin, nothing happens.

3. Without moving the mouse cursor from where you clicked before the Y, press and 
hold the left mouse button.

4. Drag the mouse to the lower right corner of the document until all the text you typed is 
selected.
As you drag the mouse, text that is selected changes from a white background to black 
and the text color changes from black to white.
This example showed how to select text from top to bottom (or left to right). You can 
also select text from bottom to top (or right to left). The direction does not matter, as 
long as you only select the desired text.
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5. When you have selected all the text, release the mouse button.

Note: As you become more proficient with using the mouse and selecting text, you can 
skip step 2. You do not need to click first before positioning the mouse cursor 
from where you want to start selecting text, clicking and holding the mouse button 
and selecting text.

To change line spacing

On the right side of the toolbar are three tools used to change the line spacing.

• With the text still selected from the previous procedure, click on the triple line spac-
ing tool.
The selected text now appears with extra spaces between the lines.

To change text size

The text size determines how large or small the text is in the document. This size is the 
same size that is printed. Do not confuse the text size with the Zoom tool. The Zoom tool 
enlarges and reduces the size of text, but only on the screen, not the contents of the 
document and what is printed.
1. With the text still selected from the previous procedure, click on the Text Size tool.

Single space Triple space
Double space
4-24



PROGRAMS
A list of available test sizes displays.

2. From the list, select 14.
The selected text now appears with the selected text size.

To justify a line

The Text Justification tools in the toolbar are used to align a paragraph between the page 
margins.

Left-justification is the default, where all the text you type starts from the left margin and 
moves to the right. Other ways of justifying text are:

• Center - text is centered between the left and right margins. As you type, the text is 
always justified between the margins relative to the center of the line.

• Right - text is justified from the right side of the page. As you type, characters appear 
on the right side of the line and move to the left.

• Full - text is balanced between the left and right margins. This is used primarily when 
you write large paragraphs of text to have the right side line up evenly. This is accom-
plished by inserting extra blank spaces between words, which may look odd if the 
spacing becomes too large.

1. Select the first line of the text you typed.
2. Click the Center Paragraph tool.

The selected line appears centered between the margins.
3. Select the third line.

Left-justify Full-justify

Center Right-justify
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4. Click the Center Paragraph tool.
The selected line appears centered between the margins.

5. Select the last line.
6. Click the Right Paragraph tool.

The selected line appears right-justified.

To change text appearance

You can emphasize certain words by applying fonts and text styles to a paragraph, word or 
character. Font refers to the design of each character. A text style is an attribute of a font, 
such as bold, italic, or underlined. The GlobalPC comes with several fonts; the default is 
URW Roman. Additional fonts are available from the MyTurn.com Web site.
1. Select the first line.
2. From the toolbar, click on the Text Font tool.

A list of text fonts displays.

3. Select Superb.
Since this is a heading, it should be larger.

4. Click the Text Size tool.
5. Select 24.

To emphasize certain words, you can italicize them using the Text Style tool.

6. Select

wonderful

Default text, no 
style

Underline

Bold Italics
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A shortcut for selecting a word is to place the mouse cursor on the word and double-
click. Triple-clicking selects the whole line.

7. Click on the Italics tool.
Refer to the MyTurn.com Web site for additional help with some of the Writer 
features, such as spell checking and importing graphics.

ARTIST
Artist is a graphic drawing program with many powerful features. It includes drawing 
tools to create geometric shapes and a text tool to add text in different styles and 
orientations.
You can add colors and patterns and use a variety of line widths. You can create some of 
these special effects:

• Draw objects and change size or proportions

• Create text and rotate or flip the text
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Opening and Closing the Artist Program

To start Artist:

1. From the GlobalPC Desktop, click Create and use Documents
The Create and use documents screen displays, as shown in the Design Assistant 
section.

2. Click Blank Document.
The Create something from a blank page screen displays, as shown in the Design 
Assistant section.

3. Click Blank drawing.
The Artist window displays.

The Title bar, at the top of the window, contains the name of the program and the name 
of the current document. When you create a blank document, the document is called 
Untitled by default. You need to save the document to give the document a name, and 
to store any work you do for future retrieval.

To save the new document:

1. From the File menu, click Save.
Since the document has not yet been defined, the Save As a New Document window 
displays, as shown in the Writer section.
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2. For the example used in this guide, type the following:

My artist file

3. Click Save.
The Artist window displays with the document name in the Title bar.

To close Artist:

1. From the Title bar, click Done.
The Done window displays, as shown in the Writer section.
If you did not save the document, the Save it so I can use it again later button is 
available. Click the button to save the document before closing the program. If you do 
not save the document, any changes you made since the document was last saved are 
deleted.
If you want to print the document before closing the program, click the Print my 
document button.
If you decide that you do not want to close the program at this time and want to return 
to the document to continue working on it, click the Go back to my document button. 

2. Click Close the document and exit Artist button.

Using Artist
After creating a blank document the Artist window displays an electronic drawing board. 
It includes a drawing area and toolbar that contains tools for drawing, moving, and 
reshaping objects. The dotted margin lines around the edge of the drawing area define the 
printable area of the page. When you create your drawing, objects that extend beyond the 
dotted lines will not print.

To draw a rectangle:

You will now practice using Artist to draw objects.
1. From the toolbar, click on the Rectangle tool.

Notice that as you move the cursor onto the drawing area, the mouse cursor changes to 
indicate you are in drawing mode.

Rectangle tool
4-29



GLOBALPC GETTING STARTED GUIDE
A rectangle is drawn by positioning the mouse cursor where you want one corner of 
the rectangle to begin.

2. Position the mouse cursor in the middle of the drawing area, hold down the left mouse 
button, and drag the mouse in the direction you want to create the rectangle.
You can drag the mouse vertically or horizontally to make the rectangle taller or wider.

3. Drag the mouse to create a rectangle similar to the one shown.

4. When the rectangle is the size you want, release the mouse button.
As you draw, do not worry if an object is not exactly the right shape or is not 
positioned where you want it. You can easily move or resize an object, or delete it and 
try again.
You can manipulate objects in other ways, not described in this guide.
For example, you can:
• Flip and rotate an object to an angle from the Transform menu.
• Change the color of an object from the Attributes menu.
• Edit the text font, style, and size from the Text menu.
• Place one object on top of another object, thereby hiding part or all of the object 

underneath. Often it is exactly the effect that you want. Objects are layered when 
they overlap each other. You can change the layering of objects by arranging the 
objects in the stack from the front to back. Object layering is changed from the 
Arrange menu.

Handles
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To move the rectangle:

After drawing the rectangle, you can move it to another location within the drawing area.
1. From the toolbar, click on the Selector tool.

2. Click on the rectangle to select the rectangle.
Notice the small rectangles around the rectangle and in the center of the rectangle. 
These are called handles, which indicate a selected object. 

The handles on the side of the rectangle are used to resize the rectangle. The handle in 
the middle is used to move the rectangle.

3. Position the mouse cursor on the center handle.
4. Press and hold the left mouse button and drag the rectangle to the desired location.

To resize the rectangle:

After drawing the rectangle, you can change the size or shape of an object.
1. From the toolbar, click on the Selector tool.
2. Click on the rectangle to select the rectangle.
3. Position the mouse cursor on a corner handle to resize the object in either the 

horizontally or vertically.
Position the mouse cursor on a side handle to resize the object in only the vertical or 
horizontal direction, 
Refer to the Support section of the MyTurn.com Web site for additional help with 
some of the other Artist features.

Selector tool

Handles
4-31



GLOBALPC GETTING STARTED GUIDE
SPREADSHEET
Use the Spreadsheet program to organize text and numbers into rows and columns. The 
advantages of using Spreadsheet instead of Writer are:

• Sorting columns of text alphabetically
• Using formulas to simplify calculations, such as adding a long list of numbers
• Being able to change variables in a formula and get instant results

Opening and Closing a Spreadsheet

To start Spreadsheet

1. From the GlobalPC Desktop, click Create and use documents.
The Create and use documents screen displays, as shown in the Design Assistant 
section.

2. Click Blank document.
The Create something from a blank page screen displays, as shown in the Design 
Assistant section.

3. Click Blank spreadsheet.
The Spreadsheet window displays.

The Title bar, at the top of the window, contains the name of the program and the name 
of the current document. When you create a blank document, the document is called 
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Untitled by default. You need to save the document to give the document a name and 
to store any work you do for future retrieval.

To save the new document:

1. From the File menu, click Save.
Since the document has not yet been defined, the Save As a New Document window 
displays, as shown in the Writer section.

2. For the example used in this guide, type the following:

My spreadsheet

3. Click Save.
The Spreadsheet window displays with the document name in the Title bar.

To close Spreadsheet:

1. From the Title bar, click Done.
The Done window displays, as shown in the Writer section.
If you did not save the document, the Save it so I can use it again later button is 
available. Click the button to save the document before closing the program. If you do 
not save the document any changes you made since the document was last saved are 
deleted.
If you want to print the document before closing the program, click the Print my 
document button.
If you decide that you do not want to close the program at this time and return to the 
document to continue working on it, click the Go back to my document button. 

2. Click Close the document and exit Spreadsheet button.
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Using Spreadsheet
After creating a blank document, the Spreadsheet window displays, ready for you start 
creating your document. This section explains how to use some of the Spreadsheet tools to 
create a document similar to the one shown below.

Information in a spreadsheet is organized by rows and columns. The area where you enter 
information is called a cell. Cells are referenced by column and row addresses. For 
example, the top left cell address is A1. The column letter is always first and the row 
number is always second.
To use the text formatting tools, see the Writer section.

To enter information a cell

Cells are selected by using the mouse or the directional keys, on the right side of the 
keyboard. The current cell is indicated by the dark border around the cell.
1. Select cell A2.
2. Type:

Sales Forecasts for June 2000

As you type the text, it appears in the Cell Contents field, on the top of the window. 
3. Press Enter.

The text you typed in the previous step appears in the selected cell. The Cell Contents 
field always shows the cell contents. If you use a formula, described later in this 
section, the formula appears in the Cell Contents field and the result of the formula 
appears in the cell. You edit the cell contents from the Cell Contents field.
Text that is longer than the size of a cell will extend beyond the right margin of a cell, 
provided the cell to the right of the current cell does not contain any information. If the 
cell to the right does contain information, then the current cell contents is cut off. The 
information is still in the cell, but it cannot be displayed. You can resize the cell width 
to accommodate longer text.
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To change the column width:

1. In cells A3 through A5, enter the following:

Sales Rep East

Sales Rep Midwest

Sales Rep West

2. In cells B3 through B5, enter the following:

60,000

35,000

75,000

Notice how the complete contents of cells A3 through A5 do not display. To have the 
contents display, you need to resize the column width for column A.

3. On the column header, place the cursor on the separator line between columns A and 
B.
The cursor changes to indicate the column margin.

4. Leaving the mouse cursor on the column margin, press and hold the left mouse button, 
and drag the column margin to the right.

5. Release the mouse button.
The column changes to show the new column width. You may need to do this several 
times to achieve the desired column width. This does not affect the cell contents, only 
the appearance of the spreadsheet on the display and how the spreadsheet appears 
when printed.
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To use a formula

Using formulas can get very complicated. This section describes the SUM formula, which 
is used to total a list of numbers. This is one of many formulas. For more examples, refer 
to the MyTurn.com Web site.
In this section you will create a spreadsheet similar to the following:

1. Select cell B6.
2. From the Formula menu, select Insert Function.
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The Insert Function window displays.

3. In the left column, select the Math functions.
4. In the right column, select SUM.
5. Click Paste.
6. Click Close.

The SUM function is inserted in the cell with variables to show the format of the cell. 
You need to edit the formula to include the actual values you want to calculate.

7. Replace the following in the Cell Contents field

value1, value2,...

with

B3, B4, B5

8. Press Enter.
The total for the numbers entered in B3, B4, and B5 displays in B6.

BANNERMAKER
Instructions for using the BannerMaker program are available in the Support section of the 
MyTurn.com Web site.
4-37



GLOBALPC GETTING STARTED GUIDE
INFORMATION ORGANIZATION SUITE
The Information Organization Suite consists of the following programs:

• Calendar
• Address Book
• Banker
• Database

Instructions for using the games are available in the Support section of the MyTurn.com 
Web site.

PLAY AND LEARN SUITE
The Play and Learn Suite consists of the following programs:

• Crossword
• Learning Center
• Solitaire
• Tetris

Instructions for using the games are available in the Support section of the MyTurn.com 
Web site.

COMPUTER UTILITIES SUITE
The Computer Utilities Suite consists of the following programs:

• Add and Delete Software
• Backup Manager
• Dial-up and Configure
• Preferences
• System Update
• Unplug GlobalPC

Instructions for using the computer utilities are available in the Support section of the 
MyTurn.com Web site.
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Find answers to some of the commonly asked questions. 
  A

SOLVING PROBLEMS
Before calling technical support you may find solutions to problems you might encounter 
with the GlobalPC in this chapter. Most of the troubleshooting issues listed were compiled 
from frequently asked questions to our technical support team. The tips in this section will 
help get you on the right track with your GlobalPC. 
The following topics are covered:

• Start Up 
• Display
• Keyboard
• Mouse 
• Modem
• Internet/Email 

STARTUP PROBLEMS

Why won’t my computer turn on?
• Is the GlobalPC properly connected? 

Check each of your connections very carefully to make sure all the plugs are seated 
securely. When the GlobalPC is powered on you’ll see a small green light illuminated 
on the front panel. 
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• Is the power supply cord plugged into the wall and into the connector at the rear of 
the GlobalPC? 
Make sure your power supply cord is plugged into the wall and into the back of the 
GlobalPC. Check the rear panel to insure that the barrel-shaped end of the power cord 
fits securely into the connector marked POWER CORD. If the cord is loosened your 
computer won’t receive power. 

• Are you using a power strip?
If you are using a power strip check to see that the switch is turned on and that the 
strip is plugged into the wall. 

• Is your AC outlet controlled by a switch? 
If it is, turn the switch on. You can also choose to plug into a different outlet to elimi-
nate this step. 

• Is the outlet you are using defective?
Check another outlet to rule out this problem. 

If the GlobalPC is on but you can’t see anything on the screen, troubleshoot your display 
using the tips below as a guide. Often times it seems as if the computer is not working 
when the problem is actually with the display. If after troubleshooting the computer and 
display, your GlobalPC still doesn’t receive power, call technical support at (877) 698-
8761 to determine if your machine is defective. 

DISPLAY PROBLEMS

Why doesn’t anything come up on the screen when I turn on my 
computer?

• Is the display plugged into an AC outlet?
If the display is plugged in but it still doesn’t work, check to make sure the AC outlet 
isn’t controlled by a switch. If it is, turn the switch on or try another outlet. 

• Is the display connected to the GlobalPC properly?
When using a monitor, the cable should be plugged into the VGA monitor connector 
located on the rear panel of the GlobalPC. 
When using a TV, a TV video cable (provided with your GlobalPC) should be con-
nected to the video output jack on the rear panel of the GlobalPC and to the televi-
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sion’s input jack. If your TV doesn’t have an input jack, you’ll need to use the TV 
converter. (see Display Installation on page 1-10 for instructions on how to connect 
the GlobalPC to a TV using an TV converter). 

• Is the display itself turned on?
Make sure your display is turned on. If you are using a monitor, look for a button 
(should be round or square) on the outside, front edge of the monitor and make sure it 
is on. A small green light will be illuminated when the monitor is in the ON position. 

• Is the GlobalPC in sleep mode? 
When the computer is in sleep mode, the on/off light on the front panel is not illumi-
nated so it appears as if it’s turned off. Press the button on the front of the GlobalPC. 
You’ll know whether the monitor was in sleep mode if, once you press this button, the 
screen pops up with an image. 

My computer seems to be on but all I see on the screen is a TV show.
If your TV is still showing sitcoms and reruns when you want to run your GlobalPC, ask 
yourself the following:

• Are you on the correct channel?
If you are using an TV converter, try switching to channel 3 or 4. 

• Did you try using the AUX channel?
If your TV supports multiple modes, then you may need to use AUX instead of chan-
nels 3 and 4.
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MOUSE PROBLEMS

Why doesn’t the mouse cursor move anywhere on the screen?
• Is the mouse plugged into the green connector on the back of the GlobalPC? 

Make sure the plug on your mouse cord is firmly attached to the mouse connector on 
the rear panel. A loose connection could disable your mouse.

• Check to see if the roller ball on the underside of your mouse is clean. 
Often times this area of the mouse will collect debris, especially if you don’t use a 
mouse pad. Using a pad (we provide one for you) will help keep your mouse cleaner 
longer. If your mouse needs to be cleaned, follow the instructions below.

How to clean your mouse
Shut down your GlobalPC.

Pick up the mouse and turn it over so you can see the roller ball.

Remove the plastic frame that holds the ball in place. To do this push down on 
the area and slide up until the frame clicks and releases. 

Once the frame is removed, turn the mouse over and catch the roller ball with 
your other hand. 

Take a cotton ball dampened with rubbing alcohol and gently clean the 
surface of the roller ball.

When finished cleaning, dry the roller ball with a lint-free cloth.

Blow into the roller ball cavity on your mouse to remove excess dust and then 
place the ball back inside. 

Position the frame back in place and click shut.
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KEYBOARD PROBLEMS

I’m typing but the keyboard isn’t responding.
• Is the keyboard cable properly seated in its purple connector? 

The plug can only fit in the purple keyboard connector one way (with the arrow fac-
ing up). If plugged in correctly, the plug will fit in the connector easily. Never force 
the plug into the connector; you may bend the pins in the plug and damage the cable. 

• Restart the GlobalPC.
If the keyboard still doesn’t work after connecting the plug properly, restart the com-
puter. Turn off the on/off button on the front panel first and then turn off the power 
switch on the rear panel. Wait a few moments (about 15 seconds) and then turn the 
power back on.

Why don’t the arrow keys work?
• Have you turned off number lock? 

The directional keys on the number pad won’t work unless you turn off number lock. 
To turn it off, press the “Num Lock” key to deactivate the green light on the keyboard.

MODEM PROBLEMS

Why can’t I get online?
• Is your phone line operating? 

Your modem won’t work if you are using an inoperable phone line. Make sure your 
phone line is in working order by connecting a phone and checking to see if you hear 
a dial tone when you pick up the receiver. If you don’t hear a tone, use another phone 
jack, if available, or contact your phone service provider to fix your phone line. 

• How secure are your modem connections? 
Make sure your phone line is connected properly to the modem connection on the rear 
panel of the GlobalPC. The plastic phone plug should be completely inserted into the 
modem connector. Check the connection at the phone jack as well, to make sure the 
plug isn’t loose or improperly seated.

• Do you have call waiting on your telephone line?
If the phone line you are using has call waiting, you will need to disable it temporarily 
while you are online. Call waiting can interrupt the modem connection and bump you 
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off the Internet. To turn off call waiting select the option to “disable call waiting” dur-
ing the registration process. 

If you didn’t disable call waiting when you registered your Global PC, you can 
choose this option by clicking the Internet and Email icon and then selecting Manage 
Internet Settings.  Once clicking on the Manage Internet Settings icon,  a window 
entitled Internet Dial-up will pop on the screen. Select  Options from the menu bar 
located near the top of this window. The Options menu will bring up Dialing Options.  
Select this option to bring up the Dialing Options window. When you are in this win-
dow look for Prefix to disable call waiting and type in the star key and the number 70 
with no spaces like this: *70.  Once you do this, click the Change button. You have 
now disabled call waiting.

• Did you pick up the phone while you were trying to connect online?
If you pick up the phone while you are emailing or browsing the Internet, you risk 
losing your online connection. Sometimes you can get away with preserving connec-
tions if you hang up quickly, but usually once you pick up the phone you’ve caused 
enough interference to get disconnected.

INTERNET/EMAIL PROBLEMS

I can’t send email
• Do you have the correct email address?

Double-check the address of the person you are trying to email. If just one character 
is off it can prevent you from emailing successfully.

• Is the address composed correctly?
The correct way to compose an email address is to type in the name of the person you 
are sending email to, an “@”, then the address followed by a period and the Web site 
location. There should be absolutely no spaces between words. The address should 
read something like this: name@address.com or JDoe@Large.com 

For a more detailed explanation on what each of the elements in a email address 
mean, read Internet Basics on page B-1.

• How do I make an “@” for my address?
You can make this character by holding down the shift key and typing the number “2” 
on your keyboard. Use the number “2”key above the letter “W”, not the one on the 
number pad.
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SOLVING PROBLEMS
I can’t get on the Internet.
• Do you have an online connection?

See the above section about modems to determine if your modem connections are 
working.

• Are your Internet settings correct?
If you are having a problem dialing up and the cause is due to your Internet settings, 
you will receive a message entitled, “Check Internet Settings.” If after reading 
through the suggestions there you still aren’t sure what to do,
call technical support. 

The Web page is incomplete/not showing.
• Have you tried using the scroll bar?

Usually you need to click the scroll bar to the right of the Web page in order to see the 
whole page. If you are unsure of how to use the scroll bar, press the “Learn” key on 
your keyboard and practice this function in Lesson 3.

• Did you try reloading the Web page you want to view?
If you are using a monitor, click the reload button located below menu bar on
the Internet screen. 

If you are using a TV, select “Reload” from the “View” menu.

If after using this troubleshooting guide you need more assistance, call technical support: 
(877) 698-8751.
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When you enter information, there may be times when you 
want to enter a character that does not appear on the 
keyboard.
  B

SPECIAL CHARAC-
TERS
Special characters are those special letters that you see in some words, such as a foreign 
name. Use the following table to determine the keystrokes required to produced the 
desired character.

TABLE OF SPECIAL CHARACTERS
To enter a character from the table press all the indicated keys in the sequence shown. The 
Shift, Ctrl, and Alt keys correspond to the keys on the keyboard. The + character means to 
press and hold the sequence of keys shown. For example, to enter the Ä character, the first 
character in the table, press and hold the Crtl, Alt, and u keys at the same time and release the keys. 
Then press the Shift and A keys at the same time. 
Notice that upper and lower case characters are used 
in the keystrokes.

Ñ Ctrl+Alt+n N

Ö Ctrl+Alt+u O

Ü Ctrl+Alt+u U

á Ctrl+Alt+e a

Character KeystrokeCharacter Keystroke

Ä Ctrl+Alt+u A

Å Shift+Ctrl+Alt+a

Ç Shift+Ctrl+Alt+c

É Ctrl+Alt+e E
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à Ctrl+Alt+a

â Ctrl+Alt+i a

ä Ctrl+Alt+u a

ã Ctrl+Alt+n a

å Ctrl+Alt+a

ç Ctrl+Alt+c

é Ctrl+Alt+e e

è Ctrl+Alt+` e 

ê Ctrl+Alt+i e

ë Ctrl+Alt+u e

í Ctrl+Alt+e i

ì Ctrl+Alt+` i

î Ctrl+Alt+i i

ï Ctrl+Alt+u i

ñ Ctrl+Alt+n n

ó Ctrl+Alt+e o

ò Ctrl+Alt+` o

ô Ctrl+Alt+i o

ö Ctrl+Alt+u o

õ Ctrl+Alt+n o

ú Ctrl+Alt+e n

ù Ctrl+Alt+` n

û Ctrl+Alt+i n

Character Keystroke

ü Ctrl+Alt+u u

† Ctrl+Alt+t

° Shift+Ctrl+Alt+8

¢ Ctrl+Alt+4

£ Ctrl+Alt+3

§ Ctrl+Alt+6

• Ctrl+Alt+8

¶ Ctrl+Alt+7

ß Ctrl+Alt+s

® Ctrl+Alt+r

© Ctrl+Alt+g

™ Ctrl+Alt+2

/ Ctrl+Alt+e Space

“ Ctrl+Alt+u Space

Æ Shift+Ctrl+Alt+`

Ø Shift+Ctrl+Alt+0

∞ Shift+Ctrl+Alt+5

± Shift+Ctrl+Alt+=

≤ Ctrl+Alt+,

≥ Ctrl+Alt+.

¥ Ctrl+Alt+y

µ Ctrl+Alt+m

π Ctrl+Alt+p

Character Keystroke
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ª Ctrl+Alt+9

º Ctrl+Alt+O

Ω Ctrl+Alt+z

æ Ctrl+Alt+’

ø Ctrl+Alt+o

¿ Shift+Ctrl+Alt+/

¡ Ctrl+Alt+1

¬ Ctrl+Alt+l

√ Ctrl+Alt+v

ƒ Ctrl+Alt+f

≈ Ctrl+Alt+x

« Ctrl+Alt+\

» Shift+Ctrl+Alt+\

… Ctrl+Alt+;

Blank Alt+Space

À Ctrl+Alt+` A

Â Ctrl+Alt+n A

Œ Shift+Ctrl+Alt+q

œ Ctrl+Alt+q

– Ctrl+Alt+-

— Shift+Ctrl+Alt+-

“ Shift+Ctrl+Alt+[

‘ Ctrl+Alt+]

Character Keystroke

‘ Shift+Ctrl+Alt+]

÷ Ctrl+Alt+/

ÿ Ctrl+Alt+u y

Ÿ Ctrl+Alt+u Y

¤ Shift+Ctrl+Alt+4

ý Ctrl+Alt+e y

Ý Ctrl+Alt+e Y

‡ Shift+Ctrl+Alt+t

‚ Shift+Ctrl+Alt+1

„ Shift+Ctrl+Alt+;

‰ Shift+Ctrl+Alt+5

Â Ctrl+Alt+i A

Ê Ctrl+Alt+i E

Á Ctrl+Alt+e A

Ë Ctrl+Alt+u E

È Ctrl+Alt+` E

Í Ctrl+Alt+e I

Î Ctrl+Alt+i I

Ï Ctrl+Alt+u I

Ì Ctrl+Alt+` I

Ó Ctrl+Alt+e O

Ô Ctrl+Alt+i O

Ò Ctrl+Alt+` O

Character Keystroke
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Ú Ctrl+Alt+e U

Û Ctrl+Alt+i U

Ù Ctrl+Alt+` U

Character Keystroke
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Understanding what the Internet and email are will make 
your surfing experience more pleasurable.
  C

INTERNET BASICS
The Internet, also called World Wide Web or Web for short, is a vast network of computers 
connected all around the world to deliver information and buy or sell products.

YOUR ONLINE CONNECTION
MyTurn.com provides your connection to the Internet. The Internet is like a system of 
roads and freeways. Some people even refer to the Internet as the Information 
Superhighway. From any road in any city, you can get to almost any other road in any 
other city. From your computer, you can send an electronic mail message (email) to 
another computer anywhere in the world – instantaneously and cheaply.
MyTurn.com and other Internet access companies provide the onramps to the Information 
Superhighway – a physical connection that allows you to access the Internet. GlobalPC 
Online has fast onramps in hundreds of cities. These onramps, also called POPs (Points of 
Presence).
Your computer uses the built-in modem to call one of the MyTurn.com Internet dial-up 
numbers that connects you to the Internet. After you login by providing your user name 
and password, you have access to all the resources of the Internet. Access to the Internet is 
accomplished by using the Internet program, also called a Web browser. With the browser 
you can surf the Internet, which refers to finding Web sites (other computers) that contain 
information that you are looking for.
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INTERNET WEB SITES
Information on the Internet is located on computers owned by other people. These 
computer locations are called Web sites. The information that you see is formatted into 
pages that you can view with the Internet browser. Each Web site has a starting page called 
the homepage.

WEB SITE ADDRESS
Each Web site has a unique address called a URL (Uniform Resource Locator), which 
identifies each page on the Web site, called Web pages. The addressing concept is similar 
to street addresses in the real world. A typical address is:

http://www.myturn.com

The address for each Web page starts with http://, which stands for Hypertext Transfer 
Protocol. This identifies the address that follows as a Web page address. The next part of 
the Web page address, www.myturn.com, is the Web site address. The com reference 
designates the type of Web site. Some typical extensions are:

• com – commercial
• edu – education (colleges and universities)
• gov – government
• org – nonprofit organizations
• net – network companies

The last part of the Web page address, home.html, is the Web page name. The Web page 
extension, html, is required. You will see all types of extension – htm, asp, and others. 
They designate the type of information contained on the Web page that the browser 
automatically interprets.

LINKS TO OTHER WEB PAGES
Many Web pages have special text or images called links. A link is used to automatically 
jump to another page or another location on the current page. A text link is usual 
designated in blue and underlined to show that it is a link. When you place the mouse 
cursor on a link, notice the cursor changes to indicate the selected text is a link. When you 
click on the link the selected Web page displays.
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